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# Family Module name Problem Module Description How To Fix Manually Correction name
1 Abbreviation Usage Abbreviation Could be 

Used
If an abbreviation is listed in the abbreviation table along 
with it's description, then the best practice is to use the 
abbreviation in the document, and not the description.

The module searches the document and tries to find places 
where a description of an abbreviation is used instead of the 
abbreviation itself.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, change the description to it's 
abbreviation.

Use Abbreviation

2 Abbreviation Usage Abbreviation Defined 
Later

If an abbreviation is used in the document, the author 
has to add the description of the abbreviation at the first 
use of the abbreviation. If the abbreviation is used 
before the description added, the document readers 
may not know what the abbreviation means.

The module identifies and reports all instances where the 
description of an abbreviation is used instead of the abbreviation 
itself, but the abbreviation has already been defined earlier in 
the document. In such cases, there is no need to repeat the 
description.

If the author wishes to exclude certain parts of the document 
(such as headings or captions) from the abbreviation check, 
these can be specified in the abbreviation preferences. The 
module will then skip these ignored document parts.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, move the description to the 
first occurrence of the abbreviation.

Delete Description
Move Description

3 Abbreviation  Table Abbreviation Table Order 
Issue

Entering the items into the abbreviation table without 
alphabetically ordered makes it difficult for the readers 

 to find the abbreviaƟons. 

This inspection module verifies whether the abbreviations in the 
table are listed alphabetically. If the abbreviation table contains 
a header row, it will be excluded from the alphabetical sorting.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, you can sort the table with 
Word's table sort function.

Sort Table

4 Link Blue Text Not Linked It is not recommended to format texts  as hyperlink, e.g. 
blue text: RGB(0, 0, 255), without setting the internal 
link, because readers can misinterpret plain blue texts as 
links.

The module lists all parts of the document that are colored blue, 
but have neither one or more hyperlinks nor cross-references, 
covering the whole text. If the blue coloring is applied over 
multiple paragraphs, it is reported as a single issue.

Create the missing internal link manually or 
by using OnStyle Internal Link tool.

N.A.

5 Labeling Boxed Warning Issue The structure of the US Prescribing Information 
document is regulated in 201.56(a) and (d) and 201.57. If 
the requirements about the place and format of the 
boxed warnings are not met, it could lead to a rejection 
of the document.

The module checks if the boxed warning is present in the 
Highlights section of a USPI document, and checks if the length 
of the exceeds 20 lines. (This includes white space but does not 
include the BW title and the statement “See full prescribing 
information for complete boxed warning.”)

Add the boxed warning table or shorten 
the content of it to meet the FDA 
requirements.

N.A.

6 Style and Format Character Formatting 
Applied

The document can contain character formatted parts 
(e.g., bold is directly applied to the text, without using 
styles), which is not recommended but it may be allowed 
in certain cases in the document.

This module lists the paragraphs or words of the document 
where the used style is changed with applying character 
formatting options (e.g., bold, italic, etc.).

Consider removing the character 
formatting elements and applying styles 
whenever it is possible.

Clear Character Formatting

7 Style and Format Character Style Applied The document can contain paragraphs where both 
paragraph style and character style are applied at the 
same time.

This inspection module finds and lists all document parts that 
have text level formatting, which means that a character style is 
applied to the document part.

The issues are grouped by the applied style to make it easier to 
remove every occurrence of a character style.

Consider to remove manually the character 
style of document part.

Clear Character Style

8 Harvard Citation Citation Cross-Reference 
Target Mismatch

The cross-reference on the citation helps the user to 
check the literature references. If the target is wrong, it 
is difficult to find the reference section or paragraph.

A cross-reference on a citation must either point to the actual 
reference paragraph that is being cited, or the Reference title. 
Whichever is the company standard, it can be set in module 
configuration and this check will ensure that the correct target is 
set.

Remove the wrong cross-reference, and 
place a correct one, for example with  the 
internal link tool of OnStyle.

N.A.
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9 Harvard Citation Citation Hyperlink Target 

Mismatch
The hyperlink of the citation helps the user to check the 
literature references. If the target is wrong, it is difficult 
to find the reference section or paragraph.

A hyperlink on a citation must either point to the actual 
reference paragraph that is being cited, or the Reference title. 
Whichever is the company standard, it can be set in module 
configuration and this check will ensure that the correct target is 
set.

Remove the wrong hyperlink, and place a 
correct one, for example with  the internal 
link tool of OnStyle.

N.A.

10 Harvard Citation Citation with Partial 
Cross-Reference

If the cross-reference is placed only to a part of the 
citation, it can be difficult to navigate to the target of the 
hyperlink.

This issue is raised when OnStyle finds a cross-reference that has 
not been added to the whole citation, only a part of it.

Remove the wrong cross-reference, and 
place a correct one, for example with  the 
internal link tool of OnStyle.

N.A.

11 Harvard Citation Citation with Partial 
Hyperlink

If the hyperlink is placed only to a part of the citation, it 
can be difficult to navigate to the target of the hyperlink.

This issue is raised when OnStyle finds a hyperlink that has not 
been added to the whole citation, only a part of it.

Remove the wrong hyperlink, and place a 
correct one, for example with  the internal 
link tool of OnStyle.

N.A.

12 Labeling Column Number Issue The structure of the US Prescribing Information 
document is regulated in 201.56(a) and (d) and 201.57. If 
the column formatting requirements are not followed for 
TOC, Highlights and FPI sections, the document might be 

 rejected. 

The module checks if the Highlights and TOC sections are in two-
column format and the FPI section is in single-column format 
within the USPI document.

Use the built-in Microsoft Word tool to 
change the number of columns to the 
request value.

N.A.

13 Labeling Column Spacing Issue The structure of the US Prescribing Information 
document is regulated in 201.56(a) and (d) and 201.57. If 
the column formatting requirements - including the 
spacing settings between columns - are not followed for 
TOC, Highlights and FPI sections, the document might be 

 rejected. 

The module checks the uniformity of column widths in multi-
column sections, and checks whether column spacing settings in 
these sections comply with the preconfigured values within the 
USPI document.

Use the integrated Microsoft Word tool to 
enable 'equal column width' and adjust the 
spacing of multi-column sections to the 
specified value.

Set Column Spacing

14 Diagnostic Comment Not 
Anonymized

Whenever a user adds a comment to a document, the 
name of the user can be visible in the comment box. For 
security reasons it is not acceptable if the document is 
planned to be sent outside of the company.

The module reports all comments (including the replies in a 
thread) where the author of the comment is not anonymized, 
i.e. the author is not one of the allowed authors. The issues are 
grouped by the authors of the comments.

There is no easy solution for changing the 
 author of a comment manually. 

N.A.

15 Diagnostic Comment Present The document can contain comments from the review 
process, but final documents should not contain any. 
Comments are of no use after the authoring phase; they 
can interfere with readability and excessive comments 
can slow down Word.

This OnStyle function finds all the existing comments in the 
document, irrespective of their status, and lists them in the 
Inspection Results pane.

Review and remove these comments by 
Word's built-in function in the Review 
Ribbon / Comment Section.

Remove Comment

16 Style and Format Corrupt Style Alias Style aliases may be confusing as they change the default 
style name. Due to an error in earlier versions of Word, a 
high number of style aliases with technical issues (e.g., 
Char, Graphic) may appear. While using the Draft View, 
the styles used for the row are written beside the text 
body. If a style has a long alias, this view can become 
unreadable.

This module finds the styles having corrupted aliases in their 
names.

Consider if the style alias is really required, 
and if it is not, remove it.

Remove Style Alias
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17 Link Cross-Reference Broken The document can contain cross-references with no valid 

target. This could be caused by, for example, creating a 
cross-reference to a heading title that was later deleted. 
In this case, the referenced text will not be available in 
the document anymore causing the cross-reference to 
claim “Error...” once updated. A broken cross-reference 
is not acceptable by the authorities.

This OnStyle function reports all cross-references without a valid 
target in the document. An invalid target means that the target 
bookmark is not available, so its text cannot be updated in the 
field.

Remove the invalid cross-reference or 
correct its target.

Remove Text
Remove Cross-Reference

18 Style and Format Cross-Reference 
Formatting Issue

It is a good practice to highlight (e.g., with blue color) 
texts containing cross-references to another document 
part. Formatting rules of cross-references are usually 
described in the company style guide or in the technical 
guide of the Health Authorities.

Breaking this rule makes difficult to navigate in the 
document.

The module identifies and reports all cross-references within the 
document which are not formatted according to the rules 
described in the DocConfig.

Add the required formatting manually, or 
create the cross-reference with OnStyle’s 
Internal Link Tool.

N.A.

19 Style and Format Default Tab Stop Changed It is possible that the default tab stop defined in the 
template may be manually overridden, causing the text 
layout in the document to differ from the expected.

The module compares the document's default tab stop settings 
with the template defined in the DocConfig and reports an 
‘Unexpected tab stop found’ issue in case any differences found.

Set the default tab stop settings in 
Paragraph Settings > Tabs so that they align 
with the values expected by the 
configuration.

Reset Default Tab Stop

20 Diagnostic DocDefaults Present The existing document defaults stored in Normal 
template, can change the document's layout and styles 
without any user interaction. This could lead to hardly 
understandable issues in various inspection modules.

The module finds and lists all entries of the DocDefaults, except 
those that are listed in the module parameters as an exception.

Deleting, renaming, or moving the Normal 
template removes all stored defaults. The 
Normal template is automatically recreated 
after the next Word start.

N.A.

21 Diagnostic DocGrid Present The DocGrid element specifies the settings for the 
document grid, which enables precise layout of full-width 
East Asian language characters within a document by 
specifying the desired number of characters per line and 
lines per page for all East Asian text content in this 
section. If a DocGrid element is set in the default 
settings, the layout of all new documents are impacted, 
which means that the margins of the standard page 
layout are changed.

The module checks all sections of the document if a DocGrid is 
defined, and reports the type and place of the DocGrid element 
found. These DocGrid elements are reported:

Line and character grid

Line grid only

Text snaps to character grid

Change the settings in the Page layout tool, 
on the Document Grid tab to ‘No Grid’.

N.A.

22 Diagnostic Document Property 
Value Issue

Most companies use custom properties in the document 
templates, which are essential for the document 
management processes. If the user changes the value of 
these properties, it can cause exceptions in the processes.

The module finds and lists the document properties which do 
not have the required value. One issue per invalid property value 
is reported. The issue contains the name of the property and the 
current value. If the property has no value, the string <empty> is 
displayed in the issue text. If the property is missing from the 
document, the string <missing> is displayed in the issue text.

Correct the value of the reported 
document property (File > Info > Properties 
> Advanced Properties option).

Set Document Property
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23 Content Document Revisions Final documents should not have tracked changes. 

Tracked changes are of no use after the authoring phase; 
they can interfere with readability and excessively 
tracked changes can slow down Word.

This OnStyle module finds the tracked changes made in the 
document. Before finalizing a document, all pending document 
revisions must be accepted or rejected, and Track Changes must 
be turned off. The changes can be accepted or rejected on the 
Review tab of the Ribbon.

Accept or reject all revisions before 
finalizing the document using Word's built-
in functions on the Review ribbon.

Accept Change
Reject Change
Hardcode Tracked Change 

24 Numbering and List Duplicated Heading 
Numbering

The heading might contain duplicate numbering because 
the author had previously inserted a manual number, 
which was then updated by the auto-numbered Heading 
style during DocConfig assignment. As a result, both the 
manual and automatic numbers appear (e.g., “1 1. 
Introduction”). This causes inconsistency in the 
document and may lead to errors in the Table of 
Contents.

This module identifies heading paragraphs that are styled with 
auto-numbered Heading levels but also contain a manually typed 
number at the start of the line.

Delete the manually typed number from 
the beginning of the heading, keeping only 
the style-based automatic number.

Remove Duplicated Heading 
Numbering

25 Image Embedded Object The document can contain embedded objects (e.g., Excel 
tables, charts, PowerPoint, PDF or Word objects). These 
active objects can cause problems during PDF rendition, 
so it is recommended to remove them from the 
document.

This OnStyle module finds and lists all objects in the document 
embedded from different other applications.

Remove the embedded objects manually. Make Not Active

26 Abbreviation  Table Empty Abbreviation 
Table Cell

An empty cell in the abbreviation table means that either 
 an abbreviaƟon or a descripƟon is missing. 

The module reports any empty cells in the abbreviation table, 
including those that are completely empty or contain only 
whitespace characters. If both the abbreviation and description 
cells are empty in a row, the entire row is reported as a single 
issue.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, fill the empty table with the 
necessary information.

Delete Table Row

27 Caption Empty Caption A caption of a table or figure can be empty easily, in case 
their place is prepared quickly, but the related title was 
forgotten to be added. Tables or figures without valid 
caption text cannot be referenced correctly in the 
documents.

The module finds all table and figure captions based on the style 
defined in the DocConfig, and lists those which has no caption 
free text, only the mandatory labels and numbering are filled.

All caption texts are reported as empty which contain only 
whitespace characters.

You can fill in the empty title manually with 
the correct content.

Remove Text

28 Content Empty Heading Paragraphs with heading styles which are empty or 
contain only whitespace characters are not
recommended, because it can break the uniform outlook.

The module reports all heading paragraphs that are empty or 
contain only whitespace characters.

All empty headings are highlighted on the 
result pane, but it is useful to turn on 
'Show all formatting marks' to see them all. 
Delete the highlighted content.

Remove Text

29 Diagnostic Empty Key Property Most companies use custom properties in the document 
templates, which are essential for the document 
management processes. If the user forgets to fill in these 
properties, it can cause exceptions in the processes.

This OnStyle function checks whether the defined document 
properties are filled:

There is no correction module that can be launched to fix this 
problem, so it must be fixed manually by setting the correct 
document property values from Word’s File* > *Info menu.

Fill in the missing key properties (File > Info 
> Properties > Advanced Properties option).

N.A.
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30 Content Empty Page If the document contains pages with no visible content, 

then empty pages will appear in the printout and in the 
rendition.

This check lists all pages with no visible content. Remove the unnecessary page breaks and 
whitespace characters manually.

Remove Empty Page

31 Content Empty Paragraph The document can contain recurring enters appearing as 
empty paragraphs to set spacing. It is not recommended 
to set the paragraph spacing or document pagination by 
inserting empty paragraphs (pressing Enter more than 
once) because it makes the document format unstable.

A paragraph is reported as an empty paragraph if it contains only 
a paragraph mark and whitespace characters (specified in the 
inventory)

By default, all paragraphs are checked, but the user can exclude 
one or more styles from the check.

Delete unnecessary empty paragraphs and 
use the paragraph spacing option to set 
spacing.

Remove Text

32 Content Endnote Present In Microsoft Word, an endnote is a reference, 
explanation, or comment that appears at the end of the 
document. It is often used to provide additional 
information, cite sources, or clarify points made in the 
main text. Endnotes are typically indicated by a 
superscript number or symbol in the main text, and the 
corresponding endnote text is placed at the end of the 
document.

In certain types of documents, endnotes aren't allowed 
because they may cause issues during the PDF 
generation.

The module finds and reports all endnotes within the document. 
The issue navigates to the endnote reference. The issue text in 
the inspection result window is the endnote text.

Note: It is possible to create additional cross-references pointing 
to a given endnote. These cases will not be reported by this 
module.

Select the endnote reference and remove 
the endnote manually.

N.A.

33 Style and Format External Reference 
Formatting

It is a good practice to mark the external references with 
a special formatting (e.q., red text) during the document 
editing, and adding the references only as a last step of 

 the authoring. 

This module finds all text marked as an external reference (e.g. 
red color formatting manually or using the external reference 
tool) which must be linked and lists them. The module checks 
the paragraph style, the character style, and also the text level 
formatting.

If a paragraph is formatted with a style that is excluded, this 
paragraph is not reported (even if any part of the paragraph is 
over-formatted with a character style)

If the color of the visible text is different from the color of the 
external reference configuration, no issue is reported (even if the 
text has red style formatting, but it is overwritten)

Create the missing link or remove external 
reference formatting manually.

Remove External Reference 
Formatting

34 Content Footnote Present In Microsoft Word, a footnote is a reference, 
explanation, or comment that appears at the bottom of 
a page. It is often used to provide additional information, 
cite sources, or clarify points made in the main text. 
Footnotes are typically indicated by a superscript 
number or symbol in the main text, and the 
corresponding footnote text is placed at the bottom of 
the page.

In certain types of documents, footnotes aren't allowed 
because they may cause issues during the PDF 
generation.

The module finds and reports all footnotes within the document. 
The issue navigates to the footnote reference. The issue text in 
the inspection result window is the footnote text.

Note: It is possible to create additional cross-references pointing 
to a given footnote. These cases will not be reported by this 
module.

Select the footnote reference and remove 
the footnote manually.

N.A.
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35 Link Heading Hyperlink Target 

Mismatch
If the document contains internal hyperlinks to section 
titles, this hyperlink has to point to the mentioned 
section, otherwise the navigation is hard in the 

 document. 

The module checks all hyperlinks of the document which point to 
a heading paragraph, and reports those where the hyperlink text 
does not match the section title text.

Match means case insensitivity and removed trailing whitespaces.

Correct the hyperlink manually, or with 
OnStyle's Internal Hyperlink tool

Fix Heading Link
Remove Hyperlink

36 Link Heading Link Not Set Whenever a heading title is referenced in the document, 
it makes the navigation easier if the heading is linked to 
the reference.

The module finds all paragraphs in the document which match to 
a heading text, and there is no or only partial hyperlink or cross-
reference on the text, pointing to the heading. The module 
ignores the TOC styles.

Match means case insensitivity and removed trailing whitespaces.

Place a hyperlink or cross-reference to the 
heading text manually or with OnStyle's 
internal Link tool.

Fix Heading Link

37 Numbering and List Heading Numbering Issue If the document contains numbered heading styles, it is 
not recommended to change or remove the numbering 
manually. Misnumbered headings can be confusing and 
are not automatically refreshed in the TOC.

This module lists cases where the numbering of a heading is 
manually removed or reformatted. It also lists paragraphs that 
are not numbered but should be according to their style 
definition.

Re-apply the heading style to the 
paragraph.

Reset Paragraph Format

38 Page Heading or Title with 
Break

If a table, figure, appendix, or attachment title, or 
heading that is referenced in the TOC contains a page or 
section break, the break might cause issues in the 
document and in the bookmark structure of the PDF 
rendition generated.

This module finds and lists all headings and titles that contain a 
page or section break and are referenced in the TOC.

Remove the page or section breaks 
manually.

Remove Manual Page or 
Section Break

39 Numbering and List Heading Out of Sequence The document can contain out of sequence heading 
lines, which is not recommended because they could 
cause PDF rendition issues.

The rules of the heading level sequences are as follows:

A heading level N can be followed by a heading level N+1 (next 
level) or heading level N (same level) or heading level < N (any 
previous level).

The module finds all headings in the document with invalid 
predecessor heading.

Check the numbering sequence of the 
item, and apply the correct heading style.

N.A.

40 Special Character Heading Whitespace In heading lines whitespace characters before or after 
the actual text are not allowed, because it can break the 
uniform outlook.

This module reports all heading lines which contain whitespace 
characters before or after the heading text.

All whitespace characters are highlighted 
on the result pane, but it is useful to turn 
on 'Show all formatting marks' to see them 
all. Delete the highlighted content.

Remove Heading Whitespace

41 Style and Format Hidden Text Present The document might contain text that is formatted 
hidden. Hidden texts are invisible so they can easily slip 
through multiple reviews and make their way into the 
final version.

The module finds and lists all text that is formatted to be hidden. 
The hidden formatting can be added to a text with character 
formatting or with style property setting. In order to show the 
hidden document parts, the ‘show hidden text’ option has to be 
switched on.

Remove the hidden text manually. Remove Hidden Formatting
Remove Text

42 Style and Format Highlighted Text The document can contain highlighted text for 
subsequent references. These text items need to be 
removed from the final document to meet authority 
standards.

The module finds all the highlighted text parts of the document. 
A continuously highlighted text part is listed as one result even if 
that part contains highlights with different colors.

Remove the highlighted parts or the 
highlights manually.

Remove Highlight
Remove Text
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43 Link Hyperlink to External 

Document
External document references can easily become 
corrupted upon moving or sending the document. If an 
external document is not available at the destination the 
link is directed to, it will not open, resulting in lost 
information.

Links to external documents can cause issues if the document is 
not available at the location from which they were originally 
inserted. All links are examined: if the hyperlink has an Anchor, it 
serves as an external link. Otherwise, the check determines 
whether it is a weblink. Unless it is, the check lists it as an 
external hyperlink to a file. 
Note: Running the 'Set External Hyperlink Style' correction will 
retain the original error regarding the existence of the external 
hyperlink, but its style will conform to the standard.

h3. 

Make sure the hyperlink is really needed 
for the external document. If it is not, 
delete it.

Remove Hyperlink
Set External Hyperlink Style

44 Style and Format Hyperlink without 
Hyperlink Style

It is recommended to format the hyperlinks in the 
document with hyperlink style. It might happen that 
some hyperlinks are formatted as normal text therefore 
finding them can be quite challenging. Hyperlinks should 
not be in the document prior rendering it to PDF.

This module lists hyperlinks that lack the Hyperlink style. Apply a hyperlink style to the text using the 
Styles pane of Word.

Set Hyperlink Style

45 Image Image in Low Resolution It is not allowed in the submission documents to include 
images with low resolution.

This module filters all images that have a low resolution or are 
not compressed. Inserted images must be compressed with 
Word’s built-in Picture Format > Compress picture tool.

Change the image (e.g. re-scan) or select 
the image and choose the required 
resolution manually in Picture Format > 
Compress Pictures

N.A.

46 Image Image Not Inline Images can be inserted with text wrapping, which can 
cause several issues during PDF rendering. Other 
wrapping options can cause formatting problems within 
the document, for example, if an image is inserted in 
front of the text with In Front of Text wrapping, the 

 picture could cover the text, rendering it unreadable. 

This module lists all images that are not formatted with In Line 
with Text wrapping option.

Change the image's parameters so the 
image fits the text and becomes in line with 
it.

Set Image Inline

47 Image Image with Incorrect 
Format

It is recommended to use only  standard image formats 
in the documents, otherwise it can cause issues during 
the rendition generation.

This module finds all images that have a format different from 
the standard formats (set in the parameters), e.g., JPEG.

Convert the image to a standard format 
and replace it in the document manually

N.A.

48 Image Image with Incorrect Style Images might get inserted with an incorrect style applied. The check finds all images and compares the style of the image 
holder paragraph with the style defined in the parameters.

Change the paragraph style manually. Fix Image Style
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49 Special Character Improper Whitespace 

Usage
Improper whitespace usage often arise from typing 
habits, such as accidentally adding extra spaces or 
omitting spaces.

The use of whitespace before punctuation, after the final 
punctuation mark of a paragraph, or before the first 
character of a paragraph is often not compliant with 
standard formatting conventions. However, whitespace 
is usually required after a sentence-ending punctuation 
mark if it is not the final character of the paragraph.

The module identifies cases where whitespace is used 
unnecessarily, as well as where it is missing but should be 
present—particularly around punctuation and at the beginnings 
and ends of paragraphs.

An issue is raised in case unnecessary whitespace is found or 
whitespace is expected but not present in the text.

Such cases may include, for example:

* Whitespace is forbidden before punctuation. 
* Whitespace is forbidden before the first character of a 
paragraph.   
* Whitespace is forbidden after the last character of a 
paragraph. 
* Whitespace is mandatory after punctuation marks, except 
when the punctuation is the last character of the paragraph.

Remove the unnecessary whitespace or 
add a needed on on a correct place.

Apply Proper Whitespacing

50 Table Inconsistent Continued 
Table Structure

The structure of any sub-table within the continued table 
series can be manually changed at any time (e.g., 
modifying columns, adding new columns, etc.). While 
this does not necessarily indicate an incorrect continued 
table series, it is advisable to review each such case.

The purpose of the check module is to verify the structural 
consistency of elements within a given cont'd table series 
compared to the first element in the series. If discrepancies are 
found according to these criteria, OnStyle will notify the user 
with an '*Inconsistent Continued Table Structure*' issue raised.@

Manually remove the inappropriate 
column from the second sub-table that 
causes inconsistency.

N.A.

51 Page Inconsistent Page Layout It may occur that the document utilizes multiple distinct 
page layouts. Inconsistent usage of page layouts might 

 indicate problems during prinƟng. 

The module verifies the document's page layout settings, and if 
there are multiple page layouts in use, it reports them as an 
issue.
If the page width and height are within 10 twips, it will not be 
reported, however, margins must be set exactly to a twip for the 
check in order not to be triggered.

Informative: Using the same page layout in landscape and 
portrait mode does not count as different, therefore it does not 
pose an issue from the tool's perspective.

Apply a consistent page layout for the 
whole document using OnStyle's Page 
Layout Tool.

Fix Page Layout

52 Abbreviation  Table Incorrect Abbreviation 
Table

Document using abbreviations has to have a Table which 
contains all the used abbreviation with their description. 
This abbreviation table has to fulfil some basic 
formatting and content requirements. If an abbreviation 
table was not found, or the sanity check failed on the 
table, all other abbreviation checks result a ‘prerequisite 
missing’ issue. It is hard to find out what was the exact 
reason of not finding the abbreviation table.

The module checks the possible abbreviation tables in the 
document. If none of the examined tables pass the sanity check, 
the module reports all examined tables as an issue, along with an 
appropriate error message.

Create a table with two columns. One 
column contains the abbreviations and the 
other the corresponding descriptions. 
Make sure to create the table that aligns 
with the company standards. Other way to 
create the abbreviation table is to invoke 
the 'Create Abbreviation Table' tool of 
OnStyle.

N.A.

53 Abbreviation  Table Incorrect Abbreviation 
Table Caption

If the caption of the abbreviation table has a different 
text as expected, document readers may not find the 
abbreviation table easily.

The module reports an issue if a document contains an 
abbreviation table and table caption paragraph, but the text of 
the paragraph is not defined in Preferences.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, change the text of the title or 
caption to an accepted one.

N.A.
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54 Abbreviation  Table Incorrect Abbreviation 

Table Caption Style
If the caption of the abbreviation table is written with a 
different style as expected, document readers may not 
find the abbreviation table easily, as it may be listed in 
the TOC in a different place as expected.

The module reports an issue if a document contains an 
abbreviation table and table caption paragraph that are 
formatted with a style that is not defined in the preferences.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, change the style of the title or 
caption to an accepted one.

N.A.

55 Caption Incorrect Caption Field 
Code

Using an incorrect field code for a table or figure caption 
results inconsistent table or figure numbering in the 
document.

The module checks all paragraphs written with any of the 
allowed table or figure caption styles. If there is a field code in 
the paragraph, but does not match any of the allowed caption 
field codes, reports an issue.

Remove the incorrect caption and create a 
new one with OnStyle.

Fix Caption

56 Table Incorrect Content 
Between Continued 
Tables

The document may contain series of tables that are 
linked to the first element of the table series (using an 
additional designation element and a link pointing to the 
caption of the first table). No other document elements 
should be included among these tables that deviate from 
the series.
In addition, the document must contain the *configured 
separator elements* (e.g., the mandatory number of 
_Paragraph Space_ paragraphs defined in the DocConfig) 
between consecutive tables. Missing or altered separator 
elements also constitute a deviation from the expected 
structure.

The inspection module verifies continued tables in the document 
by ensuring that each continued table–styled paragraph is 
preceded by a table that is also part of the series.

DocConfig-dependent elements, such as paragraph spacing 
defined in the TableSeparatorParagraphs parameter, must be 
present between continued table members and are considered 
part of the valid structure.

The module reports any instances that do not meet these 
criteria:

* If required separator elements are missing, an “Separator 
missing between continued tables” issue is raised.
* If additional, non-configured elements are present, an 
“Unexpected content between continued tables” issue is raised.

The issues are grouped by tables for easier analysis.

Remove the unnecessary text manually. Fix Continued Table 
Separation
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57 Table Incorrect Continued 

Table Series
When using Cont'd tables, strict rules apply to the 
captions of individual sub-tables.

The module verifies all continued table series in the document, 
checks that the title text remains consistent (with the exception 
of the first element, which does not require the ‘continued' 
extension), and ensures that the expected field code is present 
and corresponds to the appropriate table title. The module will 
list any instances in the results that are found to be incorrect 
based on these criteria.
A valid continued table chain structure consist of a first element 
with a table title and <n> pcs of continued tables with continued 
titles. 

In the case the main table caption is missing in a continued table 
series an 'Missing main table caption' issue will be raised.
In the case of a continued table chain where an continued table 
title is invalid an 'Invalid continued table title' issue will be raised.
If the field code does not meet the expected criteria or no field 
code exists, an 'Incorrect continued field code' issue will be 
raised.

Change the non-standard caption back to 
the caption specified by DocConfig (e.g., 
"This is the original caption cont'd").

N.A.

58 Labeling Incorrect Labeling Style 
Used

The US labeling documents have separated parts with 
different formatting requirements. These formatting 
requirements are fulfilled with specific styles for each 
document part. If the styles are not correctly used, the 
document layout can be easily corrupted.

The module checks each US labeling document part, and reports:

- all paragraphs formatted with a paragraph style (or the 
paragraph part of a linked style) defined for another document 
part, and not defined for the given document part

- all texts formatted with a character style (or the character part 
of a linked style)  for another document part, and not defined for 
the given document part

The issues are grouped by document part and style.

Apply the correct style manually to the text. Convert Nonstandard Style

59 Numbering and List Incorrect List Format If a list is created or edited manually (i.e., not with the 
OnStyle authoring tools), it can easily attain a 
nonstandard format: e.g., it might have the wrong 
indentation or bullet character.

This inspection module finds all lists in the document and checks 
if their format is allowed by the assigned DocConfig.

Change manually the wrong format or 
apply a predefined list style.

Reset Paragraph Format

60 Harvard Reference Incorrect or Missing 
Reference Year

If the reference paragraph does not contain the year of 
the publication, or the year is incorrect (e.g., it is in the 
future), the the Harvard reference inspection modules 
will not deliver proper results.

Using various methods, OnStyle tries to find the year of 
publication within a reference. (The module looks for 4-digit 
numbers less than or equal to the current year). If for some 
reason it is unable to do that, or the value identified as year does 
not meet the requirement, it notifies the user.

Add a valid year to the reference 
paragraph.

Remove Text
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61 Harvard Reference Incorrect Reference 

Section
A list of industry and company standards can apply to the 
format and usage of the citations and reference lists in 
the document. A commonly known style of referencing is 
the Harvard style references which is a so-called 
'author/year' references style. OnStyle can find the 
reference section if it meets some formatting 
requirements.

The module tries to find the reference section and performs 
some sanity checks on it. If the sanity check fails, the module 
reports the issue.

Create a reference section and format it 
according to the requirements, or 

 bookmark it with 

N.A.

62 Special Character Incorrect Symbol Variant There are some special characters that have multiple 
similar representations with different codes. These 
cannot be used interchangeably. It is recommended to 
stick with the default version of every character 
throughout the document to maintain continuity and a 
standard look.

This OnStyle function searches for characters that represent an 
allowed symbol, but not with the correct character code. For 
instance, ‘' and ‘＋’ may seem identical, but the former sign, 
called ‘Plus’, has a Unicode code point of U002B, while the latter, 
'Full-width Plus’, represents U+FF0B.

The module skips the fields inserted into the document, so does 
not report if the value of a field (e.g. document property) has an 
invalid symbol.

Change or delete manually the special 
character.

Replace Symbol

63 Style and Format Incorrect Table Content 
Style

A document may contain table parts, cells formatted 
with styles that are not the correct ones to be used in 
tables. When a table content is formatted with incorrect 
styles, the final appearance of the document will not be 
uniform. This should be avoided for all tables in a 
standard document.

The table content style is created for table header and content 
formatting. This check lists the tables which are formatted with a 
different style. The issues are grouped by the tables.

If a DocConfig is assigned to the document, the tables are 
checked against the list of allowed styles of the attached 
DocConfig. If no DocConfig is assigned to the document, the 
tables are checked against the list of allowed styles of the 
inventory.

Apply an allowed table style to the text of 
the table cell, or the whole table can be 
corrected with the Apply Table Style 
function.

N.A.

64 Style and Format Instructional Style Used Usually, in templates, instructional text is used to 
describe what each section contains. Instructional texts 
must be deleted from the document because they break 
continuity and are of no use for the reader.

The module finds and lists all text written in instructional style. Remove the text written in instructional 
style.

Remove Text

65 Link Internal Hyperlink Target 
Mismatch

The document can contain internal hyperlinks where the 
target does not match the hyperlink text. This can 
happen, for example, upon inserting a table into the 
document before the targeted table, and the table 
number gets automatically increased in the original one. 
Mismatching hyperlink targets makes navigation tiring 
and unreliable.

The module identifies hyperlinks within the document where the 
displayed text of the hyperlink points to a table caption, a figure 
caption or a section heading, but the numerical value in the 
linked table or figure caption, as well as in the corresponding 
section heading, does not align with the numerical value found in 
the displayed text of the hyperlink. Whitespace differences, such 
as space versus nonbreaking space, do not yield an issue.

Check the number of the target table and 
correct the hyperlink text.

N.A.

66 Link Internal Hyperlink with 
No Target

The document can contain internal hyperlinks that have 
no valid target. This can happen when the target of an 
internal link is deleted. Hyperlinks pointing to a 
bookmark that has been deleted are broken links; they 
are going to navigate to the beginning of the document, 
which makes navigation a tiring task.

This module finds the internal hyperlinks within the document 
that do not lead to a valid target.

Assign a valid target to the hyperlink or 
remove the hyperlink.

Remove Hyperlink

Page 11 of 23



OnStyle Inspection Modules v3.6 DACHS Computing & Biosciences GmbH

# Family Module name Problem Module Description How To Fix Manually Correction name
67 Link Internal Link Not Set If a text is referring to a table, figure, or section in the 

same document but is not linked using a hyperlink, the 
module will report it as a problem. Invoking tables, 
figures or other sections of the same document should 
be done using hyperlinks, otherwise navigating the 
document can become tiring.

The module identifies and reports document parts where the 
displayed text appears as if were a reference to a table caption, a 
figure caption or a section heading, but  there is no hyperlink 
added either to the text or the number following the text.

Create the missing internal hyperlink 
manually by using OnStyle Internal Link 
tool with Hyperlink type on the selected 
text.

Scroll to Target

68 Content Internal Reference 
Document

The document can contain internal references to other 
documents which have a document name with 
predefined format. These references have to be linked to 
reference section, otherwise the navigation in the 
document can become complicated.

Module finds all document parts that match the patterns defined 
in the parameters but the reference formatting is not correct.

Format and link the internal document 
reference as required.

N.A.

69 Caption Invalid Caption Heading 
Level

The numbering of the table and figure captions can be 
configured to include different level of headings. If the 
referenced heading level does not exist, or can be found 
only in a previous section, the table or figure numbering 
van be easily corrupted. (Either references to an 
unwanted section, or the field evaluation results an error)

This module finds all table and figure captions which have invalid 
level switch in Reference field code. The inspection module will 
result issues only if the table and figure captions are configured 
to contain heading level references. All captions are reported 
where the referenced heading level does not exist, or can be 
found only in a previous section.

The best way to correct this issue manually 
is to re-create the caption with OnStyle's 
insert table or figure caption function. In 
this case only the valid levels will be 
selectable in the drop-down.

Fix Caption

70 Caption Invalid Caption Label Text A Table Figure Caption can easily be formatted 
incorrectly, with a missing or incorrect caption label text. 
Using caption labels differently as defined, some useful 
inspections will not result all issues.

The inspection module checks all paragraphs written with any 
valid caption style if the label text matches with the specified 
label text.

You can edit the wrong caption label text 
manually.

Fix Caption

71 Harvard Citation Invalid Citation Format The company style guide contains the required format of 
the citations. Using a different format breaks the uniform 
look of the document.

Based on the configuration data, OnStyle generates the valid 
citation format for each reference. This issue is raised when a 
citation is found but with a format that does not adhere to the 
rules.

Edit the citation text manually. N.A.

72 Harvard Reference Invalid Reference 
Paragraph

The Harvard reference paragraphs should have a 
predefined format. If these format requirements are not 
met, the Harvard reference inspection modules will not 
deliver proper results.

When the reference section is located and all preliminary checks 
are passed, OnStyle starts processing the reference paragraphs 
to gather the required information from each (i.e., name and 
number of author(s), year of publication). This process can be 
fine-tuned by modifying module configuration parameters. If, for 
any reason OnStyle is unable to process a paragraph, it will raise 
an issue for it.

Format the paragraph manually according 
to the predefined format rules.

Remove Text

73 Harvard Reference Invalid Reference 
Paragraph Style

In order to run all the inspections of the Harvard 
reference section, paragraphs must be formatted with 
specific styles.

The module checks all paragraphs in the reference section, and 
reports an issue for the paragraphs that are not formatted with 
one of the allowed styles.

Format the reference paragraph with an 
allowed style manually.

Apply Style

74 Special Character Invalid Symbol The document should not contain special symbol 
characters other than those allowed by the assigned 
DocConfig. Nonstandard symbols could cause issues in 
the document PDF rendering or destroy the clean look.

This module finds and lists all special symbol characters that are 
not listed in the Symbols tool menu.

Remove or change the invalid symbol 
character manually.

N.A.
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75 Labeling Invalid USPI Document 

Structure
According to FDA requirements, the US labeling 
documents shall have a predefined structure with the 
document parts: Highlights, TOC and FPI (Full Prescribing 
Information). In order to perform other inspections of 
the labeling documents, these document parts are to be 
present in the document.

The module tries to find the three main parts of a USPI labeling 
document, and reports an issue for each missing or duplicated 
part.

The required parts (Highlights, TOC and FPI) are described with 
the title text and title style, which are configurable at DocConfig 
level. 

All text searches are case insensitive, and the whitespace 
differences are ignored.

Add the missing document parts to the 
document manually.

N.A.

76 Content Language Issue The document's proofing language should be set to US 
English, or the language defined in the DocConfig. If 
certain words or paragraphs are set to a different 
language, they may not be highlighted by proofing 
checks even though they are not written in the 
document’s language. This could cause issues later if 
readers cannot understand what is written in a 
document.

The module identifies and lists all text in the document that has 
a proofing language different from the one set previously by the 
Proofing Language tool or the DocConfig default. It displays the 
language that is set for each instance of the issue.

Set text language manually to the desired 
one.

Fix Incorrect Language

77 Link Link to Dedicated Target Health authority guidance may require to place active 
weblinks into the document. The hyperlink text and the 
target webpage is determined. In case of missing or 
misspelled active hyperlinks, the document will be 
rejected.

The module checks if all configured hyperlinks are correct in the 
document.

Create the hyperlink with Word’s hyperlink 
functions.

N.A.

78 Page Manual Page Break Hard page breaks can cause issues if the page break is 
near the end of a page and content gets inserted prior to 
the page break. This might cause the page break to slip 
to a new page and lead to an empty page. It is 
recommended to use automatic page breaks wherever 
possible.

This module lists all manual page breaks. Remove the page or section breaks 
manually.

Remove Manual Page or 
Section Break
Replace with Soft Page Break

79 Abbreviation Usage Missing Abbreviation 
Definition

If an abbreviation is used in the document, the author 
has to add the description of the abbreviation at the first 
use of the abbreviation. If this is missed, the document 
readers may not know what the abbreviation means.

The module identifies and reports all abbreviations that are not 
defined (having their description added) at their first occurrence 
in the document. 
The preferences can be customized to ignore certain document 
parts, such as headings or captions, where the author may not 
want to define the abbreviations.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, add the description of the 
abbreviation to the first occurrence.

Add Description

80 Abbreviation  Table Missing Abbreviation 
Table Caption

If the caption of the abbreviation table is missing, 
document readers may not find the abbreviation table 
easily, as it may be missing from the TOC .

The module attempts to locate the title or caption of the 
abbreviation table based on the specified style and text defined 
in the parameters.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, insert a table title or caption 
with the expected style and text.

N.A.
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81 Abbreviation  Table Missing Abbreviation 

Table Header Row
If the column headings of the abbreviation table are 
expected, but the header row is missing or not correct, 
the abbreviation modules will not be able to perform the 
inspections, or some of the inspections will report false 
issues.

If the abbreviation table header is set to mandatory and the 
abbreviation table does not contain a valid header row (meaning 
the first cell in either the abbreviation column or the description 
column does not have one of the allowed column header 
values), the module reports an issue, and selects the first row of 
the abbreviation table.
However, if the header row is defined in the abbreviation table 
and the 'mandatory' setting for the header row is 'false', no issue 
is generated.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, insert a header row manually 
with the expected header texts.

N.A.

82 Caption Missing Caption A caption of a table or figure can be missed easily, in case 
the content is coming from an external source. Tables or 
figures without captions cannot be referenced correctly 
in the documents.

The inspection module finds all tables and figures in the 
document which do not have any caption. The DocConfig defines 
the expected style(s) of the captions, and defines if the table and 
figure caption should be placed before or after the table/figure. 
The module checks the tables and figures and checks the 
paragraphs before or after the table /figure. The empty 
paragraphs are skipped, and the module checks the first non-
empty paragraph. (Empty paragraph means all paragraphs which 
are reported as empty by the ‘Empty paragraph’ inspection)

Note: The user can create a table/figure without caption with 
OnStyle’s authoring functions. This module will report these 
tables/figures as an issue, i.e., OnStyle will not know why the 
caption is missing.

You can start the OnStyle Insert Table Title 
or Insert Figure Title function manually.

Insert Caption

83 Caption Missing Caption Field 
Code

If the table and figure captions are numbered manually, 
i.e., without a field code, it can easily result incorrect 
table or figure numbering.

The module checks all paragraphs of a document written with 
any of the configured caption styles, and reports an issue if the 
paragraph does not contain any field code.

Create a caption with Word or OnStyle. Fix Caption

84 Caption Missing Caption Fix Part 
Separator

The fix part separator is the character after the table or 
figure number. A Table Figure Caption can easily be 
formatted incorrectly, with a missing caption fix part 
separator. Using caption labels differently as defined, will 
break the uniform look of the document body and the 
tables of contents.

This module finds all captions where the fix part separator is 
missing.
Parts of a caption: “CaptionLabel” “LabelSeparator” 
“ReferenceFieldCode” ”NumberSeparator” “SequenceFieldCode“ 
“FixPartSeparator“ “CustomUserDefinedText“

The best way to correct this issue manually 
is to re-create the caption with OnStyle's 
insert table or figure caption function, but 
this issue can be easily corrected by adding 
the missing separator character.

Fix Caption

85 Caption Missing Caption Label 
Separator

The label separator is the character between the caption 
label text (e.g., 'Table') and the table or figure number. A 
Table Figure Caption can easily be formatted incorrectly, 
with a missing caption label separator. Using caption 
labels differently as defined, will break the uniform look 
of the document body and the tables of contents.

This module finds the table and figure captions where the Label 
Separator is missing. 

(parts of a caption:

“CaptionLabel” “LabelSeparator” “ReferenceFieldCode” 
”NumberSeparator” “SequenceFieldCode“ “FixPartSeparator“ 
“CustomUserDefinedText“ )

The best way to correct this issue manually 
is to re-create the caption with OnStyle's 
insert table or figure caption function, but 
this issue can be easily corrected by adding 
the missing separator character.

Fix Caption

86 Harvard Citation Missing Citation Cross-
Reference

Company standards may require a cross-reference on 
the citation pointing to the reference section or to the 
reference paragraph.

The module can be configured to look for cross-references on 
each citation. An issue will be raised if no cross-reference is 
found.

Add the necessary cross-reference to the 
citation, for example with the Internal link 
tool of OnStyle.

N.A.
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87 Harvard Citation Missing Citation 

Hyperlink
Company standards may require a hyperlink on the 
citation pointing to the reference section or to the 

 reference paragraph. 

The module can be configured to look for hyperlinks on each 
citation. An issue will be raised if no hyperlink is found.

Add the necessary hyperlink to the citation, 
for example with the Internal link tool of 
OnStyle.

N.A.

88 Harvard Reference Missing Reference Author If the reference paragraph does not contain any authors, 
the the Harvard reference inspection modules will not 
deliver proper results.

Using various methods, OnStyle tries to find the author(s) of a 
publication within a reference. If for some reason it is unable to 
do that, it notifies the user.

Correct the format of the reference 
paragraph manually.

Remove Text

89 Abbreviation  Table Multiple Abbreviations 
Listed

If a single cell in the abbreviation table contains more 
abbreviation or more descriptions, the inspection 
modules will not be able to report the issues correctly. It 
is recommended to add one entry in a table cell.

The module reports all cells in the abbreviation table that 
contain more than one abbreviation or description, indicating 
the presence of multiple paragraphs within a single cell. If both 
the abbreviation and description cells contain more than one 
entry in a row, the entire row is reported as a single issue.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, split the cells containing 
multiple entries into separate cells.

Split Table Row

90 Harvard Citation Multiple Citation Cross-
References

It is not recommended to place more than one cross-
references on the same citation, because it will be hard 
to navigate to the target.

If a citation has more than one cross-reference - even if they link 
to the same target -, OnStyle will raise an issue.

Remove all unnecessary cross-references 
from the citation.

N.A.

91 Harvard Citation Multiple Citation 
Hyperlinks

It is not recommended to place more than one 
hyperlinks on the same citation, because it will be hard 
to navigate to the target.

If a citation has more than one hyperlink - even if they link to the 
same target -, OnStyle will raise an issue.

Remove all unnecessary hyperlinks from 
the citation.

N.A.

92 Style and Format Narrative Text 
Formatting Issue

Narrative text (not heading, title, table of contents, table, 
etc.) is expected to have a common format, with a fixed 
character font and specific size. If a document contains 
different fonts with varying sizes, that can make it non-
compliant.

The module lists all text that has a font and size different than 
what is specified in the inventory and is not in a predefined list of 
paragraph styles and not in a table either.

Change manually the narrative text font 
family and size formatting as required by 
using styles.

N.A.

93 Style and Format Non-black Text The document can contain text whose text color is not 
black, for example, external links.

The check identifies and lists text in the document that isn't 
black, including both directly formatted text and text with non-
black style. However, certain styles with colored text shall be 
excluded; for example, hyperlinks must remain blue, so there is 
no need to filter them.

If the colored text is applied over multiple paragraphs, it is 
reported as a single issue.

Change the color to black. Remove Non-black Text Style

94 Special Character Nonbreaking Hyphen 
Issue

Using normal hyphens inside a word can cause that the 
word is split in separate rows in the document.

The inspection module finds all places in the document where 
normal hyphen is used inside a word (i.e., before and after the 
hyphen a visible character is written) instead of a nonbreaking 
hyphen. The whole word is marked as an issue. If a word 
contains multiple hyphens, it is reported as a single issue. All 
tables of contents (TOC, LOT, LOF) are excluded from the 
inspection by default. The following characters are reported as 
invalid: ‘\u002d‘, ‘\u00ad‘ and ‘\u2011‘.

Change the normal hyphens to 
nonbreaking hyphens manually

Change to Nonbreaking 
Hyphen
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95 Special Character Nonbreaking Space Issue Using spaces between numbers and measuring units can 

cause that they are split in separate rows in the 
document.

Module checks if nonbreaking spaces are used where expected. 

Nonbreaking spaces for larger numbers, e.g., 1 000 000 
(including numbers inserted with field codes). If a number 
contains more spaces, e.g., 1 000 000 000, then it is reported as 
one issue. If a number is formatted with space, it should be a 
nonbreaking space. If other delimiter character is used, it is not 
an issue. However, if the number contains at least one space, the 
entire number will be reported as an issue, even if other 
whitespace characters are also present. If a comma is detected 
inside a number, it is treated as one number, so the comma 
character can be used as a thousand separator. (This will 
generate an issue only if there is also a space in the number.) 
Other characters that are similarly allowed inside numbers: 
period (decimal point), forward slash, multiplication symbol, 
semicolon, single or double apostrophe, as well as opening and 
closing parentheses, brackets, and braces. Only numbers with an 
absolute value greater than a configurable limit are checked.

Nonbreaking spaces between numbers and measuring units. The 
list of measuring units is stored centrally. The issue text contains 
the number and the measuring unit.

Any configured words, numbers or symbols, as specified in the 
preferences: <regex> <space> <regex>. These patterns will 
always match exactly two words, whitespace inside the regex is 
not supported. If you omit one of the regexes, it will be treated 
as a wildcard matching anything. The issue text is not only the 
space, but the the whole expression found.

Change the space to nonbreaking space 
manually.

Change to Nonbreaking Space

96 Special Character Nonbreaking Space 
Missing

The absence of a nonbreaking space (for instance, 
between numbers and their respective units of 
measurement) is considered a common typing/authoring 
error.

The module checks for missing nonbreaking space between the 
numerical value and the unit of measurement within the 
document. Additionally, symbols can be defined where a 
nonbreaking space is expected before or after.

Complete the expression with the missing 
nonbreaking space.

Add Nonbreaking Space

97 Content Nonconforming Term Using different terms for the same thing makes the 
document inconsistent and hardly understandable for 
the reader.

The module finds and reports all words and phrases which are 
configured as nonconforming. The search operates in a case-
insensitive manner, and the module locates only complete words 
when performing the inspection.

Change the term to the allowed one 
manually.

Change to Standard Term

98 Page Nonstandard Page Layout The document can contain pages with unmatching page 
sizes or margins compared to the page layout defined in 
the DocConfig. All pages in the document should have 
the same layout to maintain an even look and prevent 
problems during printing.

The check finds all sections in the document where the page 
layout is different from what is defined in the DocConfig.

If the page width and height are within 10 twips to the specified 
one, it will not be reported, however, margins must be set 
exactly to a twip for the check in order not to be triggered.

Apply a page layout using OnStyle's Page 
Layout Tool.

Fix Page Layout
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99 Style and Format Nonstandard Style Used The document can contain styles that are not specified in 

the DocConfig. For example, nonstandard styles can get 
inserted into the document by copy-pasting content 
from other documents or websites. Only standard styles 
should be used in the document to maintain a consistent 
look and feel.

The module lists all styles used in the document that are not 
defined in the DocConfig.

If the identified nonstandard style was 
used in the document, it can be changed to 
any available standard style using the Styles 
section. If there are no occurrences in the 
document anymore, it is recommended to 
delete the nonstandard style in the pop-up 
window, which can be accessed by the 
button in the bottom right corner of the 
Styles section of OnStyle.

Convert Nonstandard Style

100 Link Obsolete Cross-Reference The document can contain cross-reference fields which 
are not up to date. This can happen if during the creation 
of the document new Headings Table or Figure Captions 
are inserted into the middle of the document, and 
Update Fields function was not run.

Cross-references are inserted into the document for pointing to 
sections, tables, figures, etc. It might happen that the anchor 
text of those cross-references is not accurately representing the 
text of the target. In this case, the cross-reference field must be 
updated.

Update a field manually simply by right 
clicking on the field and selecting Update 
Field from the context menu or run the 
Update Fields function of OnStyle.

Fix Obsolete Cross-Reference

101 Abbreviation  Table Once Used Abbreviation 
Listed

The most common rules of abbreviation handling say 
that an abbreviation is to be inserted into the 
abbreviation table only if it is used more than once in the 
document.

If an abbreviation table is found, this inspection module will 
report all abbreviations that are used only once in the document, 
regardless of whether they are used as a definition or purely as 
an abbreviation and highlights the abbreviation table row

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, remove the entry from the 
abbreviation table manually, and make 
sure that the abbreviation is mentioned in 
the document with the description.

Delete Table Row

102 Caption Orphan Caption A caption of a table or figure can be easily orphaned, in 
case their place is reserved by adding the caption, but 
the related content, i.e. table or figure is missing. Table 
or figure references in the documents are unusable in 

 this case. 

The module checks all table and figure captions in the document 
based on the caption style definitions of the DocConfig if there is 
a table or figure below or above the caption (according to the 
rules defined in the DocConfig).

The caption is reported as an issue if the first non-empty 
paragraph before or after the caption is not a table or figure.

You can use the OnStyle Create Table or 
Create Figure tool to have a proper table 

 without orphan parts. 

Remove Text 

103 Content Page Number Missing Company style guides and HA rules usually require the 
presence of the page number on each page of the 
document. The title page may act as an exception for 
certain document types.

The module reports all sections of the document where the 
header or footer does not contain a page number. Only the built-
in MS Word field is accepted as a page number. The page 
number can appear on any part of the document header or 
footer.

Add the page number manually to all 
sections, or use OnStyle's Header/Footer 
Manager tool to select a pre-defined 
header or footer available for the current 
DocConfig.

N.A.

104 Page Page Size Not A4 The A4 layout is widely utilized and endorsed by 
standards, thus it is considered good practice for every 
page of a document to adhere to the A4 layout.

The module checks the layout settings of the document sections 
and reports deviations from the standard A4 layout. 

If the page width and height are within 10 twips to the A4 layout, 
it will not be reported.

OnStyle provides an excellent tool for 
setting the page size of either the entire 
document or any individual section to 
standard, accepted sizes. Additionally, 
Microsoft Word's built-in solution can also 
be utilized.

Fix Page Layout
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105 Page Page Size Not Letter The Letter layout is widely utilized and endorsed by 

standards, thus it is considered good practice for every 
page of a document to adhere to the Letter layout.

The module checks the layout settings of the document sections 
and reports deviations from the standard Letter layout.

If the page width and height are within 10 twips to the Letter 
layout, it will not be reported.

OnStyle provides an excellent tool for 
setting the page size of either the entire 
document or any individual section to 
standard, accepted sizes. Additionally, 
Microsoft Word's built-in solution can also 
be utilized.

Fix Page Layout

106 Style and Format Paragraph formatting 
applied

The document contains directly formatted paragraphs. This module finds and lists all places in the document where the 
format of the paragraph is changed by applying paragraph 
formatting.

Consider to remove manually the 
paragraph formatting.

Clear Paragraph Formatting

107 Content Placeholder Text The document contains special character combinations, 
that are used as placeholders for the 
product/component identifiers, for example, three X’s to 
note; a value is yet to be added in the field. These 
placeholders need to be replaced in the final document 
because they merely indicate the place of the 
information but do not represent it.

This module finds and lists all character combinations that are 
probably used as placeholders in the document. Typical 
placeholder character combinations are XXX, xxx, AAA, etc., but 
the module skips the commonly used ‘www’ and 'III' strings.  
Placeholder texts can be defined in the preferences. The module 
searches the specified characters as a whole word.

Replace the placeholders with the 
identifiers or insert a custom text that fills 
the placeholders' space.

Remove Text

108 Diagnostic Protected Document Password protected documents are not allowed in 
submissions.

This module checks if the document is password protected. Go to File > Info > Protect Document > 
Encrypt with Password, then clear the 
password in the Password box, and click OK.

N.A.

109 Diagnostic Read-Only Content 
Control

If the document contains read-only content control 
parts, OnStyle cannot fix any issue inside these 
document parts.

The inspection module generates an issue for all content control 
objects which are set to read-only. The issue text is the first few 
characters of the content. The module has the configured 
permission to work on read-only content controls.

The read-only protection can be removed 
in the Developer ribbon, Controls group, 
Properties.

Remove Read-Only 
Protection

110 Diagnostic Read-Only Mode The document can be set to open in read-only mode. The 
author is prompted to choose how to open the 
document after it's opened.

This module verifies the status of read-only mode in the current 
document.

Open the document in read‑only mode and 
disable the status manually in File > Info > 
Protect Document > Always Open 
Read‑Only option or remove the Mark as 
Final flag. The File > Save As is also 
applicable to make a copy of the read-only 
document.

N.A.
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111 Caption Receding Caption A caption and the table or figure may be separated and 

may be placed on different pages. It can easily happen in 
case the styles of the caption and the content are not 
linked logically. Table or figure references in the 
documents point to another page than the content itself.

If the table and figure captions are expected above the 
table/figure:

The module checks all table/figure captions (based on the style 
defined for the captions) if the paragraph property ‘keep with 
next’ is switched on for the paragraph. If not, this will be 
reported as an issue.

If the table and figure captions are expected below the 
table/figure:

The module checks all figures if the figure holder paragraph has 
the the paragraph property ‘keep with next’ is switched on. If 
not this will be reported as an issue.

The module checks all tables if the last row of the table has the 
the paragraph property ‘keep with next’ is switched on. If not 
this will be reported as an issue.

You can use the OnStyle Create Table or 
Create Figure tool to have a proper table 

 without orphan parts. 

Bind Caption

112 Harvard Reference Reference Section Order 
Issue

According to the standards, the literature reference 
sections are to be sorted by the first author and the year 
of publication.

The paragraphs in the reference section must be sorted in a 
special alphabetical order, in which the combination of the first 
author’s name and the year of the publication provide the order. 
Should there be any discrepancy, one issue will be raised for the 
whole section.

Order the paragraphs manually by the first 
author and the year of the publication.

Sort References

113 Abbreviation  Table Repeating Abbreviation 
Table Entries

If the abbreviation table contains duplicated entries, 
some of the inspections will not be able to report the 

 issues correctly. 

The module reports any duplicated entries in the abbreviation 
table, and if both the abbreviation and the description are 
duplicated within a single row, the entire row will be reported as 
a single issue.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, remove the duplicated lines 
manually. Change the duplicated 
abbreviations to different values.

Delete Table Row

114 Special Character Repeating Whitespaces The document might contain repeating whitespace 
characters.

This module identifies all text containing sequential whitespaces 
that exceeds the configured allowable amount. The characters to 
be detected is centrally defined. By default space, tab 
nonbreaking space, line break, optional hyphen are treated as 
whitespaces.
It is also configurable to exclude certain styles from the check, 
and the minimum occurrence threshold can also be adjusted 
from its default value of 3

Remove the repeating characters manually. Remove Unwanted 
Whitespaces

115 Diagnostic Restricted Access The document access can be restricted for users, which is 
not recommended in final documents.

This module verifies the status of restricted access in the current 
document.

Remove the document restrict access 
status manually in File > Info > Protect 
Document > Restrict Access option

N.A.

116 Diagnostic Restricted Editing The document editing can be restricted, which is not 
recommended in final documents.

This module checks whether the restricted editing is prepared or 
enabled on this document.

Disable the restricted editing manually 
under File > Info > Protect Document > 
Restrict Editing option.

N.A.
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117 Labeling RMC Issue The structure of the US Prescribing Information 

document is regulated in 201.56(a) and (d) and 201.57. If 
the requirements about the place and format of the RMC 
(Recent Major Changes) section are not met, it could 
lead to a rejection of the document.

The module checks if the RMC section is present in the Highlights 
section of a USPI document, starting with a preconfigured 
heading text (e.g.,“RECENT MAJOR CHANGES”) and containing 
text-based information along with its corresponding date data in 
table or table-like format.

Create the RMC section manually to 
comply with the requirements or use 
OnStyle's Headings tool and Tables tool to 
create the section.

N.A.

118 Content Special Keyword Used The document might contain specific words (e.g., “draft”) 
that the user does not wish to leave in the final version.

The module finds all text that matches the keyword(s) 
configured. Looks for whole words only. The search is case 
insensitive.

Check the document around this keyword 
and do the necessary corrections or simply 
remove the keyword.

Remove Text

119 Style and Format Standard Style Missing It is possible that the document does not contain a style 
defined as a standard style by the DocConfig, which may 
prevent it from being used during editing.

The module checks whether the styles defined by DocConfig are 
available in the given document and reports any missing style as 
issue. It can be assumed that a missing style was either deleted 
during editing or not imported due to a partial DocConfig 
assignment applied earlier.

Assign the desired DocConfig again. Add Missing Standard Style

120 Style and Format Standard Style Modified If a DocConfig is assigned to a document, it is not 
recommended to change the styles defined in the 
DocConfig, because the final appearance of the 
document will not be correct. Without knowing the exact 
settings of the expected styles, it is hard to recognize 
deviations.

This OnStyle function compares the assigned styles of the 
DocConfig, and the ones used in the document itself and lists the 
differences. If linked styles are used in the current document, 
but DocConfig contains Paragraph or Text style type then it is not 
considered as an issue because linked style covers the simple 
ones.

Apply restore styles function will reset all 
preconfigured styles that belong to the 
particular document configuration.

Fix Changed Style

121 Style and Format Strikethrough Text The document might contain text that has Strikethrough 
formatting. These text items must be removed from the 
final document.

The check finds and lists all text that has been formatted with a 
strikethrough. The issues are separated by the paragraph marks 
and table cells.

Remove the strikethrough parts manually. Remove Text
Remove Strikethrough

122 Style and Format Style to Avoid The document may contain placeholders or information 
for the authors written with a specific style. These texts 

 should be removed before the document finalizaƟon. 

The module finds all texts written with the styles listed in the 
parameter. The issues are grouped by the style.

Remove the text manually or apply a 
different style.

Remove Text
Convert Nonstandard Style

123 Special Character Symbol in TOC Source It is not recommended to use symbol fonts or special 
characters in headings that appear in the TOC because it 
can cause issues during the rendition generation. It only 
impacts characters that were inserted as Symbol font.

This module lists all headings and captions which are used as a 
source any of the TOCs, and contain symbols or special 
characters.

Remove the special characters from the 
Headings and refresh the table of contents.

Remove Text

124 Table Table Header Row Not 
Repeating

If the table does not have the header row set to repeat 
and it exceeds one page, users might not see what each 
row represents. Therefore, it is advisable to have this 
option enabled for all tables.

This module lists the tables that do not have their heading rows 
displayed on every page. The Inspection Results dialog does 
contain an internal technical ID of the table and can differ from 
the table title visible in the document.

Change the table's properties accordingly 
with Word's built-in functions.

Set Table Header Row to 
Repeat

125 Table Table Not Fitting to Page Tables with width parameters not set correctly might 
extend over the margins or, in other cases, not utilize the 
available width of the page. Further issues can surface 
when a page gets rotated, but the table does not follow 
the changed page width parameters. These issues occur 
when a table is not set to Fit to Page.

This module lists the tables where the width needs to be set 
properly to Fit to Page (from the left margin to the right margin). 
The Inspection Results pane contains an internal technical ID of 
the table and can differ from the table title visible in the 
document.

Set the table property to adjust the width 
to Fit to Page manually with Word's built-in 
functions.

Set Table to Fit to Page
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126 Table Table Not Inline In a document, tables may be inserted with text 

wrapping, which can lead to various issues, such as 
disrupting text flow and document consistency. 
Formatting challenges may arise, such as the table 
shifting positions or not appearing in the desired location 
during PDF conversion. Additionally, navigating the 
document can become more problematic. Overall, these 
problems significantly impact the document's 
professionalism and prevent it from meeting established 
standards.

This module lists all tables that are formatted with text wrapping 
‘Around’ table property.

Set the text wrapping option to “none” 
within Table Properties.

Set Table Inline

127 Table Table Split Across Pages Long tables in the document may require a table caption 
in all pages. It can be time consuming to find all long 
tables on the document manually.

The module finds all tables in the document that have the first 
and last row on different pages in the document. The module 
checks each table with the current page settings and orientation. 
If tracked changes are present in the document, the module 
checks the tables with the view setting ‘No markup’, i.e., if all 
tracked changes were accepted.  The content of the issue text is 
the corresponding table identifier.

Go through the document and search for 
the large tables manually. Split them with 
Word’s ‘Split Table’ function.

N.A.

128 Table Table with Row Break 
across Pages

A document may contain tables that have rows set to 
break across pages. When a table row is set to break 
across pages, information can become hard to find since 
it is on the previous page. This should be avoided for all 
table rows.

A property of the table is controlling whether a table row can 
split on different pages. This module checks whether this setting 
is set to false. This is recommended, because this way, the table 
has increased visibility. The Inspection Results pane contains an 
internal technical ID of the table and can differ from the table 
title visible in the document.

Adjust the table's properties so that row 
splitting is disabled.

Set Table Row Not to Break 
across Pages

129 Style and Format Table with Small Font Size A document can contain tables with small font entries. 
Small text in tables break the uniformity of the table. The 
DocConfig contains the minimum allowed table font size.

This check lists all occurrences of text in tables where the font 
size is smaller than what is specified in the Preferences dialog.

An exclusion list can be set for certain special characters 
(Nonbreaking Space, Nonbreaking Hyphen, Soft Hyphen, Tab) 
and if these characters have font sizes below the specified value, 
they will not be raised as an issue.

Change the font size of all cells in the table 
to at least the minimum recommended size 
with the standard Word function.

Set Table Cell Font Size

130 Diagnostic Textbox Present The usage of a textbox in a document can lead to various 
formatting, printing, and PDF conversion errors and 
issues, therefore it is advisable to avoid using them. 
Some OnStyle modules fail to perceive the content of the 
textboxes, thereby resulting in incomplete issue 
detection and elimination within the document.

The module locates and reports all textboxes within the 
document. The issue navigates to the location of the textbox 
occurrence. The issue text in the inspection result window 
contains the textual content of the respective textbox.

Identify and remove the textbox manually. 
If necessary, copy the textual content of 
the text box and paste it into the document 
after deleting the enclosing textbox, using 
the desired style.

N.A.

131 Diagnostic Track Changes The document has the option to Track Changes. Before 
finalizing a document, all pending document revisions 
must be reviewed (either accepted or rejected), and 
Track Changes must be turned off.

This module finds whether the Track Changes is enabled on the 
document.

Disable Track Changes manually in the 
review tab.

Disable Track Changes
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132 Diagnostic Tracked Change Not 

Anonymized
Whenever a user adds a tracked change to a document, 
the name of the user can be visible in the track change 
entry. For security reasons it is not acceptable if the 
document is planned to be sent outside of the company.

The module reports all track change entries where the author of 
the change is not anonymized, i.e. the author is not one of the 
allowed authors. The issues are grouped by the authors of the 
tracked changes. 

Some issues do not have ranges. This typically happens when a 
tracked change only contains formatting changes. In this case the 
issue is displayed as ”Issue with no range”.

There is no easy solution for changing the 
 author of a tracked change entry manually. 

N.A.

133 Abbreviation Usage Trivial Abbreviation 
Defined

There are commonly known abbreviations, like USA or 
FDA These are called trivial abbreviations and need not 
to be defined in the document body.

This module checks if any of the trivial abbreviations is defined 
based on the description in the trivial abbreviation list. If so it 
reports an issue.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, remove the description of the 
abbreviation, or remove it from the list of 
trivial abbreviations.

Delete Description
Remove from Trivial

134 Abbreviation  Table Trivial Abbreviation Listed There are commonly known abbreviations, like USA or 
FDA These are called trivial abbreviations and need not 

 to be added to the abbreviaƟons table. 

The module checks all entries in the abbreviation table to see if 
they are present in the list of trivial abbreviations. Entries in the 
list of trivial abbreviations may be flagged as allowed in the 
abbreviation table. If this flag is not set, the entry in the 
abbreviation table will be reported as an issue.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, remove the abbreviation either 
from the abbreviation table or from the list 
of trivial abbreviations.

Delete Table Row
Remove from Trivial

135 Abbreviation Usage Unlisted Abbreviation Whenever an abbreviation is used in the document more 
than one times, it has to be listed in the abbreviation 
table. If this is missed, it breaks the standard document 
authoring rules.

The module searches the document for abbreviations which are 
not listed in the abbreviation table, but they are used at least 
two times. The base of the search is the list of frequently used 
abbreviations.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, add the abbreviation and it's 
description to the abbreviation table.

Update Abbreviation Table
Add as Trivial

136 Special Character Unnecessary Whitespace Using spaces within an expression can frequently disrupt 
visual coherence and in certain instances result in their 
separation into distinct rows within the document.

The module checks for the presence of unnecessary whitespace 
within the text, where the use of whitespace shall be avoided.

Remove unnecessary whitespace manually. Remove Text

137 Abbreviation  Table Unused Abbreviation 
Listed

If the abbreviation table is copied from another 
document, it may occur that the table contains 
abbreviations which are not mentioned in the current 
document. Such errors are hard to find manually in the 
document.

The module identifies and reports all rows in the abbreviation 
table where the abbreviation is not used or defined anywhere 
else in the document.

If the prerequisite is missing, use the 
'Create Abbreviation Table' tool. 
Otherwise, remove the unnecessary entry 
from the abbreviation table.

Delete Table Row

138 Diagnostic Unused Bookmark The document can contain unused bookmarks, meaning, 
no reference is assigned to a particular bookmark. 
Unused bookmarks may appear, e.g., when the TOC is 
deleted. If there are lots of unused bookmarks, there is a 
higher chance of performance issues or crashes occurring 
during PDF rendering.

The module lists all bookmarks which do not have any reference 
in the document pointing to it. Users can navigate to the 
bookmark mentioned. Module skips the bookmarks generated 
by OnStyle for different purposes. The name of these bookmarks 
always starts with “ONS”.

Remove the unused bookmarks manually. Remove Unused Bookmark

Page 22 of 23



OnStyle Inspection Modules v3.6 DACHS Computing & Biosciences GmbH

# Family Module name Problem Module Description How To Fix Manually Correction name
139 Style and Format Unused Nonstandard 

Style
The document might contain styles that are both 
nonstandard and unused. These styles bloat the 
document with unnecessary content and increase the 
risk of accidentally applying nonstandard styles. A style is 
considered nonstandard if it is not defined in the 
DocConfig.

The check lists all styles that are not defined in the DocConfig 
and not used in the document. Let us suppose someone pasted a 
text that was written with a style named InvalidStyle, then 
deleted the text. Even though the style is not used, the tool will 
still report it.

Consider to remove the unnecessary styles 
from the document.

Remove Unused Style

140 Harvard Reference Unused Reference 
Paragraph

Copying and pasting the whole reference section from 
another document may result that references are listed 
which are not cited in the document.

Once the author(s) and the publication year are collected, 
OnStyle builds a large set of possible citation formulas, and 
searches through the document for the occurrence of any of 
them. If it cannot find a citation for a reference, it will raise an 

 issue. 

Remove the reference paragraph, or add a 
citation into the document body.

Remove Text

141 Page Watermark Present The document can contain watermark images. These 
images are not allowed in submission documents.

This module filters the watermark images. Remove watermarks from the document 
by using Word's built-in function in the 
Design ribbon.

Remove Watermark

142 Link Weblink Present The document can contain external weblinks, even if 
they are not formatted with Hyperlink style. External 
weblinks can cause security issues; therefore, it is highly 
recommended to eliminate them.

This module finds all weblinks in the document, even if their style 
differs from the hyperlink format. The weblinks configured as 
optional or mandatory are excluded from this module.

Make sure the external hyperlink is really 
needed for the external document. If it is 
not, delete it.

Remove Hyperlink

Page 23 of 23


